AV=VA

MARINE

Catview

User Guide

Www.aveva.com




AVEVA Solutions Ltd

Disclaimer

Information of a technical nature, and particulars of the product and its use, is given by AVEVA
Solutions Ltd and its subsidiaries without warranty. AVEVA Solutions Ltd and its subsidiaries disclaim
any and all warranties and conditions, expressed or implied, to the fullest extent permitted by law.

Neither the author nor AVEVA Solutions Ltd, or any of its subsidiaries, shall be liable to any person or
entity for any actions, claims, loss or damage arising from the use or possession of any information,
particulars, or errors in this publication, or any incorrect use of the product, whatsoever.

Copyright

Copyright and all other intellectual property rights in this manual and the associated software, and every
part of it (including source code, object code, any data contained in it, the manual and any other
documentation supplied with it) belongs to AVEVA Solutions Ltd or its subsidiaries.

All other rights are reserved to AVEVA Solutions Ltd and its subsidiaries. The information contained in
this document is commercially sensitive, and shall not be copied, reproduced, stored in a retrieval
system, or transmitted without the prior written permission of AVEVA Solutions Ltd. Where such
permission is granted, it expressly requires that this Disclaimer and Copyright notice is prominently
displayed at the beginning of every copy that is made.

The manual and associated documentation may not be adapted, reproduced, or copied, in any material
or electronic form, without the prior written permission of AVEVA Solutions Ltd. The user may also not
reverse engineer, decompile, copy, or adapt the associated software. Neither the whole, nor part of the
product described in this publication may be incorporated into any third-party software, product,
machine, or system without the prior written permission of AVEVA Solutions Ltd, save as permitted by
law. Any such unauthorised action is strictly prohibited, and may give rise to civil liabilities and criminal
prosecution.

The AVEVA products described in this guide are to be installed and operated strictly in accordance with
the terms and conditions of the respective licence agreements, and in accordance with the relevant
User Documentation. Unauthorised or unlicensed use of the product is strictly prohibited.

First published September 2007
© AVEVA Solutions Ltd, and its subsidiaries 2007
AVEVA Solutions Ltd, High Cross, Madingley Road, Cambridge, CB3 OHB, United Kingdom

Trademarks

AVEVA and Tribon are registered trademarks of AVEVA Solutions Ltd or its subsidiaries. Unauthorised
use of the AVEVA or Tribon trademarks is strictly forbidden.

AVEVA product names are trademarks or registered trademarks of AVEVA Solutions Ltd or its
subsidiaries, registered in the UK, Europe and other countries (worldwide).

The copyright, trade mark rights, or other intellectual property rights in any other product, its name or
logo belongs to its respective owner.



_AV:VA Catview User Guide

Catview User Guide

Contents Page
Catview

Introduction . . ... ... . . . 1:1
Catview CONtENtS . . . ..o 1:1
Installation . ... .. . . 2:1
Starting Catview . ... . 3:1
Catview Defaults . ... . 3:2
Defaults Filename . . ... ... 3:2
Standard Definition. . . . .. ... 3:2
Category PUIPOSE . . ..o 3:2
Browsing the Catalogue............ ... ... ... .. .. . . . ... 4:1
Displaying Data Sheets . .. ... . i e 4:2
Creating Specifications .......... ... ... i 5:1
Adding Components to a Specification................... ... ... ... ... 5:1
Editing Specifications. . ......... .. . . . 6:1
Changing Specification ComponentNames . . ............ .. ... 6:1
Search and Replace. . . .. ... 6:2
Step Through . . .. 6:2
Removing and Adding Bore Size Descriptions. . . . ... ittt e 6:2
General Modifications to Selected ltems. . ........ ... ... . . . . .. 6:3
Changing Component Materials. .. ... ... i 6:4

© 2007 AVEVA Solutions Ltd i 12.0



_AV:VA Catview User Guide

Modifying Wall Thickness . . ... e 6:4
Setting the STYP ... 6:5
ChangingtheShop Flag . ......... .. 6:5
Setting the Default Selection ltem ....... ... ... .. . . . . . ... 6:5
Removing a Specom from the Specification . ......... ... ... . .. . . . ... 6:5
Deleting @ SPeCOmM . . ... 6:5
Adding and Removing Bore Selectors . . .. ... 6:5
Selecting Items from the ComponentList. .. ...... ... ... ... . ... . ....... 6:6
Other Catview OptioNSs . . ... .. i e 7:1
Create PEGS Spec Data. . . ... 7:1
Create SPeC SUMMaAIY . . . ... e e e 7:1
Catview Modify Options . . ... .. i 8:1
Modify Specification .. ...... ... 8:1
Modify Exclusion List . ... .. 8:1
Category LiStS . . ..o 9:1
BOolting ... 10:1
Generating Datasheets. . ........ ... .. .. . . . Al
HOW It WOTKS ..o Al
Getting Started . ... ... A:l
Catalogue Requirements. . . . ... .. A:2
Setting Up Catalogue UDAS . ... ... . . e A:3

© 2007 AVEVA Solutions Ltd ii 12.0



_AV:VA Catview User Guide

1

1.1

Introduction

Introduction

Catview is a freeware application for building and maintaining piping specifications. It is
designed to be largely independent of catalogue naming conventions, but requires some
form of catalogue organisation for it to work.

The principle features of Catview are as follows:

Catalogue Listing and Browsing.

Display a list of component types using the category description attribute.
Sort the catalogue by generic type and standard.

Display data sheets showing catalogue items and their parameters.
Search the catalogue for specific words or phrases.

Specification Building using the Browsing functionality.

Create new piping specifications.

Build components into Specifications using the browser to select appropriate
component types.

Add a list of items using size ranges.

Ignore non-preferred sizes using an exclusion list.

Specification Editing.

Display detailed list of Specification components sorted by Component Type.

Edit component details such as Name, Stype, Material, Component Reference, Bolt
Reference and Description.

Add wall thickness details.

Specification Reporting Automatic Spec Summaries.
PEGS Specification Transfer.

Catalogue Documentation.

Produce Catalogue datasheets via OUTFITTING DRAFT.

Catview Contents

Catview is a OUTFITTING application, which works with the Standard OUTFITTING master
project MAS, as supplied with all OUTFITTING software releases. The Catview release
contains the application directories, a set of category datasheets in OUTFITTING PLOT file

format and a OUTFITTING DRAFT Macro directory for building new data sheets.
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2 Installation

To install Catview
e Insert the CD, into your CD drive.
« Wait for the CD autorun program to show the Cadcentre startup screen.
e Select the index link to list the CD contents.
* Select the Catview Product
* Follow the instructions from the install shield program
Note: The default directory for installing Catview is C:\CADCENTRE\Catview12.0. If you
choose to install the application somewhere else, you will need to edit the evars.bat

file inside the Catview directory to reflect the new location.
To do this, the line “set Catview=c:\cadcentre\Catview12.0” will need to be

changed to point to the correct directory

To add Catview to the OUTFITTING applications

« Edit the standard evars.bat file in your OUTFITTING directory to add a line to call the
Catview evars.bat file.

e Assuming you have a standard OUTFITTING installation, the following line should be
inserted at the end of the evars.bat file:

call C:\cadcentre\Catviewl2.0\evars.bat
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3 Starting Catview

To use Catview, start OUTFITTING and enter the AVEVA MAS project in PARAGON.

When installed, Catview is accessible from the PARAGON piping application under the
Utilities>Catview menu as shown:

Outfitting Paragon - Pipework Application - AVEVA Marine [Project - Master)

Paragon  Display  Query  Settings m‘meme Modify  Delete  Window  Help
Marning formst Data Checker ... CE *
Catalogue Explorer 1§ S ERETIRE '

Fiter [] r List=...
|_:_|‘, Catalogue WORL * Claimlists ..

R MASTER/EQUICATA DB Listing. .
g MASTER/ASLCATA
- MASTER/HVACCATA Reports G
- MASTERIMARSTLCATA, Guick Reparts...
W MASTERPIPECATA
¥ MASTERFIPEOLD Surface Treatment *
g MASTER/STLCATA
g MASTER/SUPPCATA, Import Data...
- MASTERIUCATALOG Conwert Spec...
-8 MASTER/UEGUICATA,
+- W Design WORL * Modify CkEys..
-l Craft WioRL*
PCORMMSKEY Report...
[+ Property WoORL * e

Madify PConns...

Catwiew.

This loads the Catview main menu as shown below:

B Catalog. .. |._|
Catview Create  Modify

From here, all of the functions of Catview can be accessed.
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3.1.1

3.1.2

3.1.3

Starting Catview

Catview Defaults

Catview needs to be able to locate certain data within the current catalogue to enable the
browsing and spec generation functions to work. The identities of what needs to be scanned
in OUTFITTING are contained in a defaults file contained in your PDMSDFLTS search path.

These can be changed by accessing the Modify>Defaults menu.

Catview defaults g |E| @
File
Defaults Filename % PDMSDFLTS TWIEWM-DFLTS
Piping Cstalogues IPDMSPIPE.CATA-ANS] [PDMSPIPE.CATA
Material Text Storage IMATERIAL
Detail Text Category JDETAIL
Standard Defintion Use CSTAMD Afribute of Category PV
Categary Purpose COMP

Dizmiss

This form controls where to look and what to look for in the database.

Defaults Filename

This is the name of the defaults file currently loaded. It is possible to use alternative files, but
the file loaded on Catview initialisation is always %PDMSDFLTS%/CATVIEW-DFLTS.
Loading and saving defaults files is done using the File menu at the top of the form.

The Piping Catalogues field is the name or names of catalogues to be scanned when
looking for component categories. If left blank, the whole MDB will be searched.

The Material Text Storage field lists the name or names of items containing material
descriptions. If left blank, the whole MDB will be scanned for material texts.

The Detail Text Category field is slightly different, because it is the name of a category or
section in which new detail texts can be created if required. This must exist and the user
must have write access to this area.

Standard Definition

Early versions of Catview used the first character of each category name to define the
category standard: A = Ansi B = British Standard D = DIN J = JIS ... New versions of
Catview and the matching MAS project now use the CSTANDARD attribute of the
categories. This option should be set to use CSTAND, but it is possible to select the old
method if required.

Category Purpose

This is the main selection criterion for selecting piping categories. At the heart of the
Catview browsing capability is the need to collect all of the correct types of category and
organise the data into the correct lists. The standard Catview default is to collect all
categories with the purpose attribute set to COMP.
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4 Browsing the Catalogue

When Catview is initialised, a collection process takes place to organise the category data
into a form which can used by Catview. This is loaded into a Browser form, which enables
the user to search the catalogue and navigate around the categories. This is called from the
Catview>Browse menu on the Catalogue Utilities form as shown.

Catalog. .. EIEIEI

Create  Modify

Catalogue Selection E| @I@

Type | Al W Standard | &l w | [ Search l

Category Mame = ABEB530 | Goocste || Finace |

Text Search | | [ Add To Specification... ]

180 Degree Bend B
3-CUT MITRE BEMD

4-CUT MITRE BEMD

AlR DREYER SPIRAX CE50 BLP

AMGLE ADJUSTMERNT

AMSIB16 11 SCRD NOZZLE BY HALF CPLG #3000

AMSIB16 11 SCRD NOZZLE BY HALF CPLG #5000

Dizplay Componert Datashest

b d

The Catalogue Selection browser form allows you to search the catalogues for component
categories by type, standard or by text search. The form shows the default listing, which is
the full catalogue regardless of type or standard. To select specific types and standards of
components, the type and standard can be selected. To refresh the selection list, press the
Search button.

A text search can be performed by typing the search text into the Text Search field and
pressing the enter key. All items containing that specific text string will be included. The
search is case sensitive.
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4.1 Displaying Data Sheets

The Cadcentre standard catalogue is supplied with a series of data sheets showing the
range of each category. These can be displayed by selecting the appropriate category and
pressing the Display Component Datasheet button. A sample datasheet is shown:

View Category Plots

[Ttem Shown = BAVGBERTT

(or|VALVE GATE ANS] B16.10 C1400 RF

Category ASVGBER  Sheet  |10of1 v

Note: The production of datasheets is done automatically, but the process can be difficult.
The macros to produce this data are provided in the Draftmacros directory as part of
the Catview release. See Generating Datasheets for details of how to produce
Category Datasheets.
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Creating Specifications

Creating Specifications

In addition to the browsing capabilities, Catview provides a mechanism for creating and
editing OUTFITTING piping specifications. The menu options for this are shown:

Catalog...

Cabview

Specification, ..
PEGS Spec Data...
Spec surmmary

To create a Specification in PARAGON, the user needs to navigate to the required
Specification World and use the Create >Specification menu. If no Specifications Worlds
exist, these can be created first. The Create Specification form is shown.

name |IF35FG |

type | Piping v

The type option indicates the type of spec to the OUTFITTING DESIGN applications. This
option sets the appropriate attributes for OUTFITTING DESIGN to find the specification.

Adding Components to a Specification

Catview provides a mechanism to enable a selection in the Catalogue browser to be used to
create entries into a Piping Specification. This is done by selecting the appropriate category
and pressing the Add To Specification button. A typical specification building sequence is
shown:
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Creating Specifications

Catalogue Selection

Type | TUEE w Stancdard |-ﬂ-|| VH Search ]

Category Mame = ALPAY00 [ Goto Cate ] [ Find CE ]

Text Search TUBE | 2cid To Specification... |

23

610 PE SLS PIPE
ASTM B42 COPPER ALLOY PIPE
ASTM BS3 COPPER ALLOY PIPE
FIPE COPPER ALLOY B32571
FIPE LIGHT B51357
SEAMLESS STAIMLESS STEEL TUBE DIM2445 B D
SEAMLESS STEEL TUBE Dir2443 B Dr

w
Dizplay Componert Datashest

The Add To Specification button lists all of the Available Specifications for the user to

make a choice. In this case, F35FG is selected and the OK button pressed to make the
selection.

Specifications :”:|[z|
Specification List

[

fd SO TN

v
o] 4 Dizmiss

This shows the Component addition form:
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Creating Specifications

Add ltems To Specification [F35FG

Category: AP 2100 Gtype: TUEBE Stype

Low Size: G w High Size: 1200 W

Bolting: More F |

Excluded Bores Material Text

5 W nane

g 1.0038 RST 372

10 1.0264 3T37.0

15 1035601 TTST3S M

-,
)
>
0134 Cancel |

20 P e e e o e e o |

£ |

[ %

This form allows you to select the size range of a component, its material, stype and in the
case of bolted items its bolt type and material. There is also a list of excluded sizes which
removes unwanted sizes from the spec input.

When the appropriate size range and material have been selected, pressing the OK button
will result in the selected items being built into the specification. At this point, the Editing
Specification form is displayed, and the user has a number of options to modify and edit
what is there.
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6 Editing Specifications

The Editing Specification form allows the user to perform a number of editing tasks on one
or all of the components in the selected Specification. The Editing Specification form is as
shown.

Editing Specification F35FG - Component Type = TUBE

Mame: | Search/Replace... v| Selected ftems: Modiy.. | Setect:

Component Generic Types |TUBE v| [ Select Specificatian...

Marme FEORO SHOP STYP Catref  Description Material Cormpr Boftr

JFISFGIAAPAIO0AS 16 TRUE & JAAPAI00DD AMSI B36.10 PE SMLS PIPE APISL GR.B =0/ =010
IF38F GIAAPAI00:20 20 TRUE &  fAAPAT00EE ANMSI B3610 PE SMLS PIPE APISL GRLE =0/ =0/0
] A 00FF 0

JF3SFGIAAPAI00E0 80 TRUE A JAAPAI00LL AMSIB3610 PE SMLS PIPE APIGL GR.B =00 =00
JFISFGIAAPAI00A00100 TRUE &  JAAPAIOORM AMSI B3610 PE SMLS PIPE APIGL GRE =00 =00
JFISFGIAAPAI00150150 TRUE & JASPAIOORR AMSI B36.10 PE SMLS PIPE APIGL GRE =00 =00
JFISF GIAAPAI00200 200 TRUE A  fASPAIOOTT ARSI B36.10 PE SMLS PIPE APISL GR.E =00 =00
JFISFGIAAPAIO0:260 260 TRUE &  JAAPAIOOWY ARSI B36.10 PE SMLES PIPE APISL GR.B =00 =010
JFISFGIAAPAI00E00 300 TRUE &  JASPAIO0W AMSI B36.10 PE SMLS PIPE APISL GR.EB=0M =010
JFISF GIAAPAI00E80 350 TRUE A fASPAIO0R ARSI B36.10 PE SMLS PIPE APISL GR.E =00 =010
JFISFGIAAPAIO0:400 400 TRUE &  JAAPAIO0YY ARSI B36.10 PE SMLS PIPE APISL GR.B =00 =010

Dizmiss

The editing functions of this form are as follows:

6.1  Changing Specification Component Names

The first option drop-down list on the Edit form deals with changing the name of
Specification Components. The options all work on the selected items in the component list.

Editing Specification F35FG - Compa

[Mame: Search/Replace... w

SearchiReplace...
Step Thraugh
Femove Second bare
Add Second Bore

IFI5F GrasPLAI0015 15 TRUE & FasPaIC

(F2EFianDadnn-2n 2n TOIIF A foapadr
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6.1.1

6.1.2

6.1.3

Editing Specifications

There are four options for changing the Specom names by selection. These are described
below:

Search and Replace

By default, Specom names are defined by [spec name]/[Category Name]:[Size 1]x[Size 2]
e.g. [F35FG/AAPA100:25

The name part - that which normally appears on an Isometric is the category name. Finally
the bores sizes are added after a colon delimiter.

Modify Mames

Search String

RFeplace String unzet

Aaply ] [ Dizmizs

The Modify Names form presents the category name for the search and replace string as
this is usually the part which needs to change. The user inputs a new name and the replace
is done on all of the selected components.

Step Through

The Step Through option provides similar functionality to the first option, but allows the user
to change each name in turn. To help the user, the full Specom name is shown on the form.

Modify Names E“E|E|

fF35F GraAPA100:25

Search String Aapad 0o
Replace String unzet

o

Removing and Adding Bore Size Descriptions

When Catview creates components, it looks at the number of connection points which
potentially have different bores. If the pointset contains more than one bore parameter, it
assumes that the component has more than one bore and creates the spec headings
accordingly. Some items such as blind flanges have two bores in the catalogue, but they are
the same value. If these are placed in a spec with other flanges, there is a potential
mismatch of spec headings. Conversely, adding reducing flanges to a set of parallel flanges
will also cause a mismatch.

The removal or addition of bores works in two operations:

© 2007 AVEVA Solutions Ltd 6:2 12.0
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6.2

Editing Specifications

¢ Changing the name
* Changing the selectors

The rename option under naming simply adds or removes the extension which contains the
bore sizes.

i.e. /[F35FG/AAPA100:25 could change to /F35FG/AAPA100:25x15.
Changing the selectors is done under the Modify Option and is described later.

General Modifications to Selected Items

Apart from changing the name, there are a number of options which can be applied to the
selected list. The general modification menu is shown:

- Component Type = TUBE
v| Selected kems:

TUBE v| Select §
| [ ee Change Materialz

Catref  Description Material o Set wial Thickness
Set Selection Type

Change Shop Flag
AAPAI00DD AMS| B36.10 PE SMLS| peorder a= Defautt

IBAPAI00EE ANSIB36.10 PE SMLS | Remove )
IBAPAI00FF ANSIB36.10 PE SMLS | Delete

IBAPA100HH ANSI B36.10 PE SMLS| Add Bore Selectar v
JBAPA100J) ANSI B36.10 PE SMLS PIPE &PIEL GR.E =00 =00

The “Modify” option shows the Edit Specification Component form, a general
Specification editor form for each component. This is as shown:

Edit Specification Component E||E|E|

T ; | currert bore = &0 Stype:
Catalogue Reference: |IMPA1 oo |[ Goto Component l

dezcription: AMS| B3EA0 PE SMLS PIPE

Detail Reference: |IMPA1 0a-or |[ Goto Detail l

Material: APISL GR.B

Material Reference: LB [ Gotomsteral | [ select..

Bott Details: Unset

Bolt Refarence: =010 Goto Bott

Compaonent Reference: =01 [ Goto Crpref l

o

This form provides facilities to change all of the Specom attributes and to navigate to
different parts of the database using the Goto buttons. The CE buttons are used to set the
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6.3

6.4

Editing Specifications

relevant attributes to use the current element in the OUTFITTING database. A check is
made to ensure that the element is of the correct type.

Changing Component Materials

Selecting the Change Materials option displays the Select Material form.

Select Material Q|E|®
Texdt Search | |
Material Text

ADMIRALTY BRASS B
ALUMIMILNM BERONZE

APISL GR.A

APISL GR.AZS

APISL GR.B

[ Pl Tl o e |

b

From this, the user selects a new material and presses the OK button to change all of the
selected components. The Text Search enables materials to be selected by searching for a
text string.

Modifying Wall Thickness

Setting the wall thickness in Catview is done by appending the wall thickness text to the
standard detailing text and creating a new SDTE element. The new SDTE element is
created in the same directory as the standard detail text (usually the component category). If
this cannot be accessed, the new detail is created in the defaults area.

Modify Wall Thickness  [= |[0|[X]
Wall Thickness Takle

unzet
SCHES
SCH10%

SCH10
SCH2Z0
SCH30

AT

Agaly Cancel

v
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6.5

6.6

6.7

6.7.1

6.8

6.8.1

Editing Specifications

Setting the STYP

By default, the stype for all components is A. This can be changed at the point when the
components are added to the spec or it can be changed using the Reset Stype form shown:

| Reset Stype E|§

Component Stype H

I Anply J I Dizmizz I

Changing the Shop Flag

The Shop Flag is used to differentiate between fabrication and erection items on piping
isometrics. Shop TRUE means that the item is to be fabricated in the workshop and shop
FALSE means it should be located at the site. The shop values are set by default for certain
items, but this can be overridden by the Change Shop Flag option. There is no form for this
action, the flag is simply swapped to its opposite value.

Setting the Default Selection Item

The order of components at each particular size determines how the list of components are
displayed on the CHOOSE form in OUTFITTING DESIGN. It also controls the default item
when the select command is used. To change the selection list, the required items need to
be selected on the form and the Reorder as Default option selected.

Removing a Specom from the Specification

The action of removing a Specom takes the item from the spec and places it in the nearest
available limbospec. This is done, by selecting the items to be removed, and selecting the
Remove option. If a limbospec does not exist, one is created.

Deleting a Specom

Deleting a Specom deletes the element entirely and all references to it will no longer work.
This can be done by selecting the required components and using the Delete option.

Adding and Removing Bore Selectors

Operations such as adding reducing flanges to a range of parallel flanges will result in a
mismatch of headings. Some items may have two bore sizes and some only one. To rectify
this, there are options for adding or removing a bore selector. To do this, select the items to
be changed and the appropriate action. Currently, Catview only deals with 1 or 2 different
bore sizes.
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6.9 Selecting Items from the Component List

The selection options provide a quick method of selecting like items. This is useful when
dealing with large numbers of components. The selection options are shown below:

S=1E3

Selection Type i | Select: Clear w
ation...
Al

Enltr % Text. ..

APIEL GR.E =08 =00

T ET I i A

The Clear option clears all selections.

The All option selects all items in the list. The Text option allows single or double level
selection by matching text strings in the list. The text selection form is shown:

select text

Search Test: |AF‘I5L |

Secondary Search: |SCH1 0 |
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Other Catview Options

7 Other Catview Options

7.1 Create PEGS Spec Data

This option produces a macro for mapping the spec details with the PEGS system. The user
is prompted for an output file, which needs to be run into PEGS as a macro.

7.2 Create Spec Summary

This outputs a spec summary to file. The user selects a spec and a file name for the output.
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8.1

8.2

Catview Modify Options

Catview Modify Options

The Full Modify menu and their functions are as shown:

Catalog... |:|.__ |E|

Catview Create BG0TEEs .
Specification. ..

Exclusion List. ..
Cakteqory Lists,., F Refresh all Lists
Defaulks, .. Add Category CE

Modify Specification

This allows you to select a specification and brings up the main Component Editor form.

Modify Exclusion List

Bore sizes like 32mm 90mm 125mm and 175mm are normally not used, although we have
some components at those sizes. The Exclusion list enables these non-preferred sizes to
be ignored by the specification building process. This option shows the Exclude Bore Size
form, which maintains the default list:

Exclude Bore Size |:|.__ |E|

Select Bores

[ >

N
LTy e

72§ o
=) =
(£

ik

= |
a
1
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Catview Modify Options
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9 Category Lists

The main browsing functions of Catview rely on data gathered when Catview starts. These
are lists of category names, types, descriptions and standards that are stored under the
browsing form. This data is collected from attributes of the component categories and forms
the backbone of the system. The attributes, which are used, are as follows:

Purpose The databases is scanned for categories with the appropriate purpose.
The default purpose is COMP

Description The description attribute provides the text description of the category
contents. This is used by the browser form for component selection.

Cdetall This is a reference attribute which points to the default detail text for the
category. Each component, which is added to a specification, will
reference this standard text.

Gtype This is a word attribute and it is used to sort the categories by generic
type such as TEE, FLAN, ELBO etc.

Cstandard This is a text field which is used to indicate the category standard, such
as Ansi, Din or BS. “none” is also used.

During a Catview session, these lists are not normally modified, but it is possible to refresh
the lists to reflect new categories or other modifications to the catalogue. This is done using
the Modify>Category Lists>Refresh All Lists menu.

Alternatively, to add a new category without regenerating the full lists use Modify>Category
Lists>Add Category CE when positioned at the required category or below.

© 2007 AVEVA Solutions Ltd

9:1 12.0



_AV:VA Catview User Guide

Category Lists

© 2007 AVEVA Solutions Ltd 9:2 12.0



_A\/:VA Catview User Guide

10

Bolting

Bolting

One of the main aims of Catview has been to make the system independent of names and
naming conventions. The only thing, which does rely on names, is bolting.

This is based on the Cadcentre component naming conventions, which are used in the MAS

project catalogue. The system uses the 5t 6t and 8™ characters to map onto a bolt with a
similar name.

e.g. flange component /AAFSBB0JJ will map onto BBJ for its rating facing and size. The bolt
set for this is could be an imperial stud bolt and this would use the characters IS, so the bolt
for this component would be /ISBBJ.

Note: Because of this mapping, the bolting side of Catview may be inappropriate for those
companies not using the Cadcentre Catalogue. This does not however remove the
benefits of Catview for general specification work and Catalogue browsing.

Adding bolts to a component set, needs to be done during the specification building
process. Selecting one of the four bolt types from the list such as “Metric Stud” will show a
bolting materials selection form and then proceed to add the bolts to the specification at the
same time as it adds the components.

Missing items will generate an error message and be ignored.

Add Items To Specification /F35FG M=

Category: AMFSERO Gtype: FLAM Stype

Low Size: 15 w High Size: g w
Balting: fore W
Mane

Metric Machine tg

Excluded Bores

Irnperial Stud

Impetial Machine ~
15 ALURIMILM EROMZE B
20 APIEL GR.A
25 — APIEL GR.A2E
; APBLGRE v
s v| & | =

| 014 Cancel

© 2007 AVEVA Solutions Ltd 10:1 12.0



_AV:VA Catview User Guide

Bolting

© 2007 AVEVA Solutions Ltd 10:2 12.0



_AV:VA Catview User Guide

Generating Datasheets

A Generating Datasheets

The files in Catview/draftmacros directory are designed to be able to produce automatic
catalogue documentation in the form of OUTFITTING DRAFT sheets for plotting or screen
viewing. The directory contains the following files:

SETUP_MAC The macro for building an MDB and all of the necessary
elements for the process to work

draftmac The main macro for building the documentation sheets

cates An example file containing a list of categories to be
documented

CATE-PARA A file showing the current values of the category OUTFITTING

DESIGN parameters for the Cadcentre Catalogue

catepara.mac This is a macro to read the file CATE-PARA and set the

required uda values for the Cadcentre Catalogue.

plotl, plot2 2 example PLOT files

A.1 How It Works

The basic idea of the draftmac macro is as follows:

1.
2.
3.

N o o s

Input the name of a category to be detailed (from the file called cates)
Go to the category and read the parameter texts

Visit each component in the category and compile a list of components and their
parameters

Calculate how many sheets are required and split the data accordingly
Create new sheets and write the text info
If the component has no Geomset, the text area is adjusted to fill the sheet.

Assuming that the component has a Geomset then draw 4 views of a component
showing the different representation types (tube on, Cl on obst on and an iso view)

Read the next category hame and repeat the process

A.2  Getting Started

Drawing catalogue components in DRAFT is not quite as straightforward as it would first
appear. In fact we cannot draw catalogue components directly so we have to resort to
drawing OUTFITTING DESIGN items instead. This is done by having a single piping
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component in OUTFITTING DESIGN, and swapping the catref of its Specom, for each
category change. To do this, we need to be able to write to the catalogue from DRAFT and
we need to visit OUTFITTING DESIGN each time to update the spatial map. The macro
SETUP.MAC is designed to build all of the data required for this purpose and to change
module access. Before you can run this, you need to change line 10 to include the name of
your master catalogue database.

After this, the macro should be run from MONITOR

Note: Because the drawing macro needs to run in and out of OUTFITTING DRAFT, it is
important to be able to get in and out of OUTFITTING DRAFT without appware
errors. This requires the addition of the sample data from the paddle DB. This can be
loaded via the ADMIN Load Sample Data menu.

Finally, you need to go into ADMIN to change fontfamily 1 to be proportionally spaced. This
is so that the columns of parameters come out nicely aligned. To do this, enter ADMIN and
type - FONTF 1 IR 6 STYLE 7.

After the set-up is completed, you need to create a file called cates, which contains the
name of all of the categories you want to document. Say this is called c:\temp\cates, you
can go to OUTFITTING DRAFT and start the documentation process with the command:

$M/c:\cadcentre\Catviewl1l.3\draftmacros\draftmac c:\temp\cates

Catalogue Requirements

The first part of the process for each sheet is to go and find the parameter description text.
This is assumed to be in two forms:

1. An ADTE element with the category description as its name e.g., /
ANSI.B16.5.BW.ELBOW

2. A series of text elements containing the parameter descriptions in the form /AABJOJH-
PA1l with an stext which describes the purpose of each parameter e.g. STEXT
‘NOMINAL SIZE'

3. Each category is assumed to have an equivalent DTEX element with a name in the for
/IAABJOJH-D i.e. category name plus -D' This DTEX element allows us to use the
description text for the component types and also allows us to find the appropriate
SKEY

4. Each category now contains a set of UDA's which allow you to set certain drawing
parameters (Like model set in PARAGON). These include:

VIEWPAR (View Direction. Default N)

:DDHEIGHT (DDHEI for nozzles etc [n * param 1])

:DDRADIUS (DDRAD for bends etc [n * param 1])

DDANGLE (DDANGLE Default 90)

:VSCALE (Scale modifier if all else fails Default = 1)

:VNOTE (Special note to be put onto the drawing - Default = unset)

-:DLOG (logical attribute to control if a drawing is produced - Default =
True)
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A.4  Setting Up Catalogue UDAS

If you leave the above UDA settings at their defaults, the draftmacro should still work, but
you might find that for some elements, the view direction or OUTFITTING DESIGN
parameters need to be set to get better results.
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